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Introduction
3D Modelling
 
Using a 3D modelling package allows us to create static objects or scenes which can be:

  printed using a 3D printer 
  imported into a video game 
  used to create a photo-realistic image 
  form the landscape for a Virtual Reality scenario

The modelling package also allows us to create animations and these can be used to:

  create an animated video 
  embedded into real world video to create special effects 
  export to a video game where the game can control execution of the animation

Blender 4.1 is, at the time of writing, the latest incarnation of this powerful, professional-level 3D model-
ling package. And, despite the fact that other, similar packages are extremely expensive, Blender is free! You 
can download Blender 3.1 from www.blender.org.

This Book
This book is aimed at the absolute beginner in 3D modelling. It will guide you, using a graphics-based, 
approach, through the fundamentals of 3D modelling and the specifics of using Blender 4.1. The pages are 
written in a way that allows you to follow along, creating your own models as you read through the pages, 
so that rather than your learning being a passive experience, it is a very active one which will not only make 
working through the book more fun, but will also help to develop and retain the skill set of a 3D modeller.

The Videos
We have also developed a set of videos which are designed to be used in conjunction with the book. The 
videos are available on our YouTube channel. You’ll also find a link to the relevant video in each section of 
the book - look for the                symbol. Click on the symbol to watch the video.

How to use the Package
A suggested approach to making use of this video/book combination is to watch the video for a particu-
lar section (most are less than 10 minutes) and then use the corresponding book section as a reminder of 
the salient points covered by the video. Once you have enough basic knowledge of modelling, we will also 
suggest activities to try for yourself which will reinforce the learning process and build up your modelling 
skills.
 
Most pages in this book are designed as a set of six panels which should be read from left to right, top to 
bottom:
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When creating models there are four basic approaches that may 
be used separately or in conjunction. The �rst of these is to modify 
the dimensions of a primitive.

The third, and most used option when modelling man-made, 
rigid shapes (known as hard body objects) is to reposition the 
vertices, edges and/or faces that make up a primitive.

A second option is to join two or more primitives to create a
new shape.

Finally, when creating organic shapes such as people or animals
many modellers use sculpting. This technique is somewhat
similar to molding clay and requires a fair degree of artistic talent!

Adding a material to an object allows us to de�ne that object’s
�nal colour and re�ectivity. For example, a material can give an 
object a dull or shiny appearance or have it appear transparent.

Once an object has been assigned a material it can also be given
a texture. A texture normally consists of one or more images 
which are assigned to the object.

Sphere width and
depth changed

Sphere and
cylinder joined 

Edge moved
upward

Image Object

1

3 4

5 6

2
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Book Conventions
Symbols are used to represent mouse and keyboard operations:

Press left mouse button

Press right mouse button

Press middle mouse button

Release left mouse button

Release right mouse button

Release middle mouse button

Double click left mouse button

Scroll mouse wheel up/down button

Scroll mouse wheel up button

Scroll mouse wheel down button

Move mouse, no buttons down

Drag mouse, middle button down

Drag mouse, left button down

Press speci�ed key on keyboard?

Enter a value from keyboard

Hold down speci�ed key
while pressing second key

???? + ?

Hold down speci�ed keys
while pressing third key

???? +???? + ?

Press �rst key then second??

Symbol Meaning

Drag mouse, right button down

Perform mouse operation at speci�ed
position (tip of arrow)

Path of mouse drag operation
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Various Blender menus and attribute settings are represented in a shortened form after their first 
occurence in the book as shown below: 

Menu entry (in Blender):

Menu Entry (in book):

Dropdown Field (in Blender):     Dropdown Field (in book):

Select All by Type
Mesh

Select

Global

Transform Orientation
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The commonest approach to 3D modelling is to start with a basic 3D 
shape, then modify it to create the final shape. Next, we add one or 
more materials to our shape to give it colour, shine and transparency as 
required. A texture image can be assigned to a material to give the shape 
the appearance of being constructed from some medium such as wood, 
stone or brick.   Finally, our scene is processed by a render engine which 
creates a final, realistic image. 
 
Of course, this is a greatly simplified view of the stages required and 
where we want to create an animated sequence rather than a still image 
there are many more steps required in the process.

In this section we’ll have a brief look at the main concepts that are 
involved in producing static 3D models.

This background knowledge will give us a good foundation for the 
remaining sections of the book where we will learn in detail how to 
create our models using Blender - a free 3D modelling package.
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In Blender, a face with three edges is known as a tri (as in triangle); 
one with four edges is called a quad (as in quadrilateral); and a 
face with more than four edges is termed an ngon (short for 
n-sided polygon and sometimes written as n-gon). 

By combining a set of faces into a group (known as a mesh), we
can create a 3D shape. Note that a vertex may be shared by more
than one edge and that an edge may be shared by more than one
face.  

Like a coin, every face
has two sides:  one side 
is  designed to be seen 
by the viewer (known 
as the front face or just 
face) and the other side 
hidden (the back face). 

If we have a sphere-like mesh, then all we can 
see are the front faces of the object (shown 
below in blue).

However, if we remove part of the sphere, 
some back faces are exposed (shown in red).

The fundamental building block of 
most 3D models is the vertex – a 
single point in space.

Two vertices can be joined  together 
by an edge.

Three or more edges can be joined to 
create a face.

3D
 M
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g 
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Front faces
only showing

Back faces

Front faces

A face

A tri A quad An ngon

A vertex An edge

A mesh

https://www.youtube.com/watch?v=ZqNJ7Sp9a6U
www.youtube.com/watch?v=1V9brH5pntE
https://www.youtube.com/watch?v=ZqNJ7Sp9a6U
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Another feature of every face is a set of normals. Normals 
may be thought of as invisible lines radiating from the 
front face (face normals) and every vertex (vertex 
normals). Face normals are always perpendicular to their 
associated face and vertex normals are perpendicular to 
the two edges that meet there.

Blender uses normals, 
not only to determine 
which side of a face is 
the front face, but also 
to calculate shadows 
and re�ections. 

Where more than one face shares a vertex, a 
vertex normal is created for each pair of edges. 

Generally, models are created by joining and/or modifying meshes. 
Most modelling packages o�er a set of basic shapes which can be 
created automatically. These are known as mesh primitives. The 
commonest primitives o�ered by Blender are shown below.

Notice that the ico sphere has tri faces  while the UV sphere has
(mostly)  quad faces.  Quads are considered the most desirable 
shape for faces when modelling.

Front face

plane

UV sphere

cone

cylinder
ico sphere

torus

cube

circle

Face
normal

Vertex
normals

Quad
faces

Tri
faces

For curved shapes, the more faces a mesh 
contains the more  realistic the model will appear.  
The number of polygons in a  model is usually 
referred to as  the polycount. 

While modelling, we can assign a temporary 
colour to the objects in our scene. This colour has 
no e�ect on the �nal result but may help make 
objects easier to see during the modelling process. 

An even more e�ective way
of creating the illusion of a 
curved surface is to adjust 
the shading.

Less faces More faces Smooth
Shading

3 Vertex
normals

     The normals of 
only one vertex 
are shown above
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When creating our scene we can move, 
rotate or scale a complete mesh...

... or we can move, rotate or scale 
parts of the mesh.

Another option is to join two or more primitives to create a
new shape.

Adding a material to an object allows us to de�ne that object’s
�nal characteristics such as colour, re�ectivity and transparency. 
For example, a material can give an object a dull or shiny �nish or 
have it appear to be made of glass.

Once an object has been assigned a material it can also be given
a texture. A texture normally consists of one or more images.

This adds a texture to the object giving the impression that the
object is constructed from the material shown in the image.

Move

Rotate
(about any axis)

Scale
(one or more

directions)

Edge
moved

Edge
scaled

Edge
rotated

Sphere and
cylinder joined 

When creating organic shapes such as people 
or animals many modellers use sculpting. This 
technique is somewhat similar to molding clay 
and requires a fair degree of artistic talent!

Image Object
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By adding the normal map image, the object appears to have a
rougher, pitted surface (depending on the nature of the new
image) without actually adding more faces to the object itself.

To add further realism to an object we can  assign a normal map 
image to the object...

...we can increase  the number of faces in the model and create 
genuine lumps and bumps on the surface.

By adding a displacement map image to the object...

Normal Map Image

Displacement Map Image

Texture Image

A sphere lit by
ambient light

By laying out the faces of an object’s mesh so that we create a �at shape,  
we can control which part of the texture image appears on each face 
(this is called UV mapping). 

Objects in a scene are only visible because they re�ect light. 
The most basic light is an ambient light in which light 
comes equally from all directions. This creates a �at light 
without shadows or highlights. 

Initial
mesh

Final
result

Mesh faces
�attened

Faces placed
over image
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A point light emits light in all directions from a single point in 
space with the light cast on an object becoming weaker the 
further the object is from the light.

Sunlight (also called directional light) casts a set of parallel 
light rays with all objects receiving the same intensity of light.
Positioning of the light is irrelevant. The angle of the light rays
can be set.

A spot light casts light within a cone-shaped volume (think of 
search light scanning the skies). Like a point light, objects at a 
distance receive less light.

Area light simulates a light originating from a �at area such as
a panel light found on a ceiling. This is a form of directional
lighting.

When creating a model, we have the option to work in 
perspective viewing mode (where objects appear smaller the 
further away they are and real-world parallel lines converge to a 
single point. 

However, it is often more accurate to work in orthographic
viewing mode where real-world parallel lines remain parallel 
and objects don’t get smaller in the distance.

Light radiates
equally in all

directions

Light radiates in
a cone-shaped

volume

Parallel light rays
radiate over the
complete scene

All objects receive
the same amount

of light

Point light

Sunlight

Spot light

Area light

Further o�
objects receive

less light

Objects outside
the cone receive

no light
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The �nal part of the process when creating a photographic-quality image or video animation is to render the model. Rendering - which 
is performed by a render engine - creates a detailed image which includes textures, shadows and re�ections. The highest quality 
renders may take minutes or even hours depending on the processing power of the computer being used.

If, rather than creating a single, static image, we wish to create an animation, then we must create a set of frames, each with a slightly 
di�erent image. These frames, when played in rapid succession, these create our animation.

Luckily, we don’t have to create each of these frames manually. Instead we create only the important frames (known as keyframes)
and Blender automatically creates the intermediate frames.

When our animation involves reshaping meshes, then we normally add an 
armature (also known as a rig or skeleton). An armature is a set of bones and 
joints. Each bone is associated with some part of the mesh.

When the bones are moved, the linked part of 
the mesh also moves. We can now add keyframes 
by adjusting the bone positions and Blender will 
create the intermediate frames with the �nal 
animation saved as either a set of still images or 
as a video �le.

Keyframe
1

Keyframe
2

Frames calculated
by Blender

Model Model with
armature

Contains
three bones

Mesh has moved
with the bones
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When creating a 3D scene, 
we need to specify the 
position of any new object.

To do this we employ axes 
which act as a type of ruler 
allowing us to measure 
distances in one, two or 
three dimensions.

If we were measuring distances in a one dimensional space (say, along a telephone wire or a 
spider thread), we could use a single, imaginary axis (known as the x-axis). The centre of the 
axis is labelled zero with positive increments to the right and negative increments to the 
left.

In two dimensional space – for example, a sheet of paper – we use 
two axes. These are perpendicular to each other and cross at their 
zero points. This meeting point is known as the origin. The new 
axis is known as the y-axis.

With the two axes, we can specify the position of any point in 
space by giving its distance along the x-axis and then along the 
y-axis. By convention these are enclosed in parentheses and 
comma-separated.

For three-dimensional space (usually written as 3D space), we need 
three axes. The third axis (z-axis) is perpendicular to the other two. Of 
course, on paper or a 2D screen we have to settle for a mental picture 
of the �nal axis coming straight out of, and into, the paper/screen.

Often, in order give a visible presence to the z-axis, it is drawn 
at 45o to the other two axes. This can lead to some confusion, 
initially.
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      In theory, the axis 
expands inde�nitely in 
both directions

The third axis
comes straight out
and into the screen

https://www.youtube.com/watch?v=sHuXGC4FIPI
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NOTE If we move our viewpoint in 3D space slightly, we 
can see all three axes.

Although the previous frame gives the traditional 
layout of the axes, Blender rotates things by 90o, 
making the z-axis vertical.  The positive end of the 
y-axis is now farthest away from our viewpoint.

To specify the coordinates of a point in three-dimensional space 
we must give its distance along each of the three axes in the order 
x, y  then z. 

Blender uses several sets of 3D axes. The most important of these 
is the World Axes. It is this set of axes that is used to specify the 
position of every object we add to a Blender scene. Only the x and 
y axes are visible initially (the z-axis has been added below).

In a Blender scene, an object’s centre (known as the object’s 
origin) is used when specifying the position of the complete 
object. This position is represented in Blender by a small orange 
circle. 

Since the Cube’s origin is at the World Axes’s origin, the Cube’s 
coordinates are given as (0,0,0).

In the last frame we 
saw that the z-axis had 
its positve direction 
�owing “inwards”  with 
the negative direction 
�owing “outwards”.
In fact, there is no 
universally agreed 
convention on this and 
we may �nd that 
di�erent software uses 
the opposite direction 
of �ow for the z-axis.

x-axis

y-axis

z-axis

x-axis

z-axis

y-axis

+

+

+

Blender Axes
Layout

3
1

7

(3,1,7)

x-axis

z-axis

y-axis

World  Axes

y-axis

z-axis

x-axis

Blender uses following 
axes colours:
     x-axis : red
     y-axis : green
     z-axis : blue

y-axis

z-axis

x-axis

Cube’s
origin

y-axis

z-axis

x-axis

Cube’s position
(0,0,0)
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Every object in Blender maintains 
several di�erent sets of axes, although, 
unlike the World Axes, the other axes 
cannot be made visible.

Two important sets of axes are the 
Global Axes and Local Axes. Every 
object in a Blender project has its own 
set of Global and Local axes.  

A less important set of axes is the View 
Axes whose position is determined by 
the location from which we are viewing 
the scene. 

These three axes types are explained 
brie�y here, but we will encounter 
other axes later in the text.

In the scene below we have a Cube object which has been moved away from its original 
position at the World Axes origin. Drawn onto the Cube are its normally invisible Global and 
Local axes. These two sets of axes initially occupy the same position and so only one set of 
axes are shown below centred on the Cube’s origin. 

If we rotate the Cube, the Global Axes remain parallel to the 
World Axes while the Local Axes rotate with the Cube. Notice that 
the Global and Local y-axis (in green) still lie along the same path 
since it is that common axis that the Cube has been rotated 

If we move the Cube, both the Global and Local axes will move 
with it, maintaining their origins at the centre of the Cube.

As we’ll see later in the text, we can use any of these axes - Global 
or Local (or any other axes set) - when moving, rotating or 
resizing objects. Below, we can see the result of moving our 
previously rotated Cube along its Local x-axis.

An object’s View axes have their orientation based on the screen’s
surface. The x and y axes are orientated in the traditional maths 
layout, x being horizontal and y vertical with the positive end of 
the z-axis coming out of the screen.

Global and
Local axes

World Axes

     Notice that the Global 
and Local axes are parallel 
to the World Axes.

Global Axes

Local Axes

     Global and Local 
axes’ origins are always 
positioned at their 
object’s origin.

New
position Moved along

Local x-axis

Old
position

z-axis

y-axis

x-axis+
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Starting  BlenderStarting  Blender

In this section we’ll identify the main elements of the Blender 
interface and have a closer look at how to use the 3D Viewport where 
we will do most of the work needed to create the basic layout of the 
scene we are working on.
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Spacebar sets which action is to be performed when 
the spacebar on the keyboard is pressed.

Theme selects the “look” (or theme) 
of the Blender window elements. 

Save New Settings saves the 
options we have selected here, using 
them in this and future projects.

Select With determines which mouse 
button is used to select objects in a scene.

 Load Blender 4.0 Settings, 
allows us to install the settings 
we may have created in our 
previous version of Blender. 
See What’s New... is a link to the 
web page showing the new 
features in this version of Blender.
Language,  allows us to choose 
which language is displayed in 
all Blender menus and messages.

Shortcuts allows us to select which keyboard 
shortcut standard we wish to use.

The very �rst time we open Blender it displays a splash screen image in the centre of its window. Look carefully, because this is 
the one and only time it will look this way. In the bottom half of the splash screen there’s a Quick Setup option.

St
ar

ti
ng

 B
le

nd
er

Splash
screen

Quick setup
options

Use Blender 2.7
shortcuts

Use shortcuts
of other 3D apps

Use current
shortcuts

Play
animation

Activate
Blender’s search

option

Use the left
mouse button
for selection

Use the right
mouse button
for selection

Toggle
toolbar display

https://www.youtube.com/watch?v=-_ACdwUWOqc
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The next time you load Blender, the Splash screen will have 
changed. Now it shows mainly �le open options including the
names of recently opened �les and the screen layout options.

Having selected General, the splash screen is removed and we are presented with the layout shown 
below.  The layout is divided into regions. The various regions are labelled below. 

When we start a new Blender 
project, chances are we’ll 
want to use the General 
layout which is the default 
option. 

We can do this by left-clicking 
on General in splash screen, 
selecting File>New File>General
from the main menu, or 
simply by clicking anywhere 
outside the splash screen. 

Workspace
layouts

Recently
opened �les

Status Bar

Topbar

Outliner
Editor

Properties
Editor

Timeline
Editor

3D Viewport
Editor

This is where we see 
the 3D scene we are 
constructing

General is the
default when 

starting a
new project

This area contains a set of 
tabbed pages. The vertical 
set of icons act as tabs to 
these pages 

This is used when creating 
animations, allowing us to 
play, pause, and move to any 
part of the animation

This area shows the items 
currently placed within our 
scene. Typical elements are 
meshes, lights and cameras

This lists the various additional 
options available for the 
operation currently being 
performed on our scene

This area contains the 
main menu and layout 
options
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Before discussing 
the various parts 
of the Blender 
interface in more 
detail, we’ll take a 
moment to see 
how the layout of 
the Blender 
window can be 
modi�ed.

One of easiest ways of adjusting the Blender workspace is by selecting a new layout from the options 
available in the Topbar. Below we can see part of the layout created by the Shading option. 

But we can also 
change individual 
elements of the 
layout. For example, 
any Editor within the 
window can be 
changed to a di�erent 
Editor by �rst clicking 
on the symbol in the 
top left of the Editor to 
be changed. Here, the 
symbol in the Outline 
Editor has been 
selected.

Once we click on the icon, a large table of Editor options appear. From the options given here, we can change the Editor displayed in 
that area of the Blender window.

W
or

ks
pa

ce
   A

dj
us

tm
en

ts

Shading

      This icon di�ers 
for each Editor.

Click the
required Editor
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The new 
Editor will 
occupy 
exactly the 
same space 
as the 
previous 
one.

Each Editor window can be resized by dragging on an edge. 

We can even split an Editor area into two separate areas by 
dragging on the hard-to-see curved boundary displayed in every 
corner of all Editors. The mouse cursor will change to crosshairs if 
over the correct position.

Below we can see the result of dragging the curved edge 
between the 3D Viewport and Outliner Editor to the left.

If we drag vertically, the area will split horizontally. Each area is completely independent, so, we could, for example, 
have di�erent viewpoints in each area (we’ll see how to change 
viewpoints shortly).

Text Editor

Drag to
resize     The Outliner 

and Properties 
Editors remain 
the same width

Original
3D Viewport

New
3D Viewport

Cursor changes
to 

New
3D Viewport

Di�erent
viewpoints
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Since each newly created area is separate and independent, we 
are free to change the Editor appearing in that area using the 
same approach as we saw earlier.

The simplest method of merging two areas into a single area is to 
start by moving the cursor over the common edge between the 
Editors - where it changes to a double arrowed line.

Right-clicking the mouse at this point produces a popup menu 
from which we need to select Join Areas.

Now we need to move the mouse into the area we wish to 
eliminate. The two options in our example are shown below.

Note that, where the common edge between the two areas to be 
merged are of a di�erent length, additional area splitting will 
occur. For example, if we try to merge the UV Editor to the 3D 
Viewport to its right...

...the 3D Viewport splits to ensure that the new area has the same 
height as the UV Editor.

UV Editor

Select new
Editor

Cursor on
common edge

Area to
eliminate

Area to
eliminate

Cursor
shape

UV Editor to
merge with
3D Viewport

Part of the original
3D Viewport area remains

Enlarged
UV Editor
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We can also see that the 
popup menu not only 
o�ers a merge option, 
but also o�ers two split 
entries. These can be 
used as an alternative 
way of splitting an area 
into two.

After selecting one of these options (Vertical Split in the example 
below), a vertical or horizontal line appears (which depends on 
the menu option selected). We can drag this to de�ne the 
width/height of the new area.

To �nalise the size of 
the new area, we 
need to click the left 
mouse button.

The resulting new 
area is shown here.

When we are working in a speci�c area of the Blender window, 
we can expand that area to occupy the full window by pressing 
one of two key sequences. Pressing Ctrl+Space when working in 
the 3D Viewport, gives the result shown below.

Pressing Ctrl+Alt+Space �lls the Blender window completely 
with the scene being constructed.  
Press the same key combination (Ctrl+Space or Ctrl+Alt+Space) 
to return to the previous layout.

Split
options

Split
line

Various options
remain

Ctrl Space Ctrl SpaceAlt
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The Topbar contains 
many 
items including the 
main menu bar and 
a set of workspace 
layouts which we 
can switch between 
as we progress  
through the various 
stages required to 
create our model.

1

Open... brings up the window shown below. Blender has its own 
format for selecting drives, folders and �les.

When Blender saves a project, it saves not only the scene we 
have been creating but also the current layout of the Blender 
window. For example, if we had the layout shown below when 
a project is saved...

...then, by default, it would  later load the �le with exactly the same 
layout. However, if we click on the Settings icon in the Load File dialog 
box and uncheck Load UI before loading our �le...

...then only the scene will be loaded and the layout of 
the Blender window will remain unchanged from its 
current state.

2

To load an existing project, we use the 
standard Open... option.

To start a new project we need to select the File|New 
option then select General from the submenu.

The main menu contains several categories but at this point, we will look brie�y at only some of 
the File  menu options.

2
1

Select a drive

Select the required folder 
then double-click on the

�le to be opened

Blender �les have
a .blend extension

W
or

ks
pa

ce
   D

et
ai

ls

Load UI

1
2

https://www.youtube.com/watch?v=RFb83YS8mCY
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If the �lename matches an existing �lename, the name will 
appear with a red background.

To save a �le as a later version of an existing �le, press the + 
symbol to the right of the �lename. This adds an incrementing 
numeric to the end of the name.

On the �rst save, we need to use Save As... , then select the drive and folder before entering the
�lename for our model and pressing the Save As button.

To open a recently accessed project, move over Open Recent...  
then select from the list of projects presented.

Recover o�ers two options. Last session reloads a �le named 
Quit.blend which is saved automatically when Blender is exited. 
Auto Save allows a previously auto-saved �le to be reloaded.  

     Blender auto-saves 
the current project at 
regular intervals

To save the current project select 
Save , Save Incremental, Save As... or Save 
Copy... from the File menu.

Four Save
options

1

Enter the
�lename

2

Die.blend

Background
red if name

already used

Die1.blend

Before

After
Number added

to �lename
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Save Incremental performs the same action as pressing the +  button 
does when we’ve used Save As. In the example below, Die.blend is 
saved using Save Incremental. This creates the new �le Die1.blend.

Save will use the 
same �lename as 
the current project 
and so overwrite the 
previously saved 
copy.

Another main menu option that will prove useful later is Render. 
The two main options here are Render Image (used to create a still 
image) and Render Animation (used to create an animation). 

When we select Render Image the rendered scene appears in a 
separate window. When rendering, we can choose between the 
Eevee and Cycles render engines. This choice is made in the 
Properties Editor’s Render page.

After

Working on
Die.blend

Saved as
Die1.blend

Save Copy at �rst appears to produce exactly the same results as 
Save As, but there is a subtle di�erence between it and the second 
option.

Let’s assume we are working on a �le called Die.blend and then 
choose the Save Incremental option (or Save As and the + button) 
which names the new �le Die1.blend. If we continue to work on 
the scene currently showing in the 3D Viewport, we will be 
working with the �le Die1.blend.

However, if we use Save Copy on our Die.blend project and press 
the + button to save the �le as Die1.blend, before continuing to 
work on the scene, we would be working with the original �le, 
Die.blend and Die1.blend would be saved as a backup storing a 
copy before any new changes were added.

After Save Incremental
After Save Copy
and + button

Working with
Die1.blend

Working with
Die.blend

Main render
options

1 2

3
Select Eevee

or Cycles

      Blender 4.1
now includes an 
Eevee Next 
render engine
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When we select Render Image the rendered scene appears in a 
separate window and this new window’s menu allows us to 
specify where the image is to be saved.

The Eevee engine is much quicker, but gives less accurate results. 

The render image’s viewpoint is determined by the Camera 
object in our scene and this will almost certainly be di�erent 
from the viewpoint used in the 3D Viewport.

The second render option in the menu is Render Animation and, as the name suggests, this is used to render an animation video or a set of 
still frames showing the state of the animation at set time intervals (see below). More on animation in a later chapter. 

The Cycles render engine gives the more accurate result, but may 
take some time to arrive at the �nal image.

Cycles Eevee

Render
viewpoint

Viewport
viewpoint
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The second section of the top bar contains a set of tabbed pages known as workspaces. Each workspace has a di�erent arrangement of 
editors. The di�erent layouts are designed to be used at various stages throughout the creation of a scene.

Workspace options Click on the + to
add a bespoke layout

The Animation workspace option.

Below is the workspace created by clicking on the UV Editing layout option.

Animation Workspace:
Used when creating an

animation

UV Editing Workspace:
Used when creating 

texturing a mesh
UV Editing

Animation

Default
option
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While clicking on the Eye or Camera icons of an object a�ects the 
that object, if we click on the same symbols to the right of 
Collection, all of the objects listed under Collection are a�ected.

Holding down Shift when we click on Collection’s Eye or Camera 
changes that setting on every object in the collection. Clicking 
without Shift will reset Collection’s icon, but not the icon of the 
objects in Collection - for that, we must hold down Shift again.

In a complex scene 
containing objects 
that are constructed 
from a number of 
meshes, it can be 
useful to create a 
collection for each 
object. 
A new collection can 
be created by 
clicking on the New 
Collection icon 
(top-right) or by right 
clicking to produce a 
popup menu and 
selecting New Collection 
from its options.

The Outliner Editor is near the top-right of the Blender window
and lists all of the objects currently within the scene. When a new
scene is created, there are three items already included: a camera,
cube and light and these are grouped together in Collection.

Clicking on the name of an item in the Outliner will select that
item in the 3D Viewport. We can tell that an item is selected by
the orange outline around it. Holding down the Shift key while
clicking allows multiple items to be selected.

1

2
Cube displays an
orange outline

3D Viewport

Within the Outliner we can change any item’s name, make it 
visible/invisible in the 3D Viewport, or have it included/excluded 
from the �nal render.

1

2

Item order changes
to maintain

alphabetic order
Not shown in
3D Viewport

Not shown in
�nal render

The green icons
indicate an

object’s type

Box, Camera,
and Light hidden
in 3D Viewport

Box, Camera,
and Light not in

�nal render

      Omitting the
camera has no 
e�ect!

2

1

Changed
to hidden

Remain
hidden

Become
visible

Shift +

Shift +
1

2

1

2New
collection

OR
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Typical use of 
collections is shown in 
the example given 
here where the 
elements that make 
up a sofa and a lamp 
stand have each been 
assigned an 
appropriately named 
collection.

New meshes are 
added to the last 
collection to have 
been selected.  

If we want to move an object to a di�erent collection, all we need 
to do is drag the object into the required collection. For example, 
here Cable is dragged from Sofa to Floor Light.

Selecting an object from 
anywhere in the Outliner and 
pressing Delete will delete 
that object. 

Deleting a collection name 
removes the collection but not 
its contents. These items now 
belong to no collection. 

To delete a collection and its contents, we need to right-click on 
the collection name and select Delete Hierarchy from the popup 
menu.

We can even nest 
collections. For 
example, below we 
can see the sort of 
structure we might 
end up creating if 
our scene shows 
the contents of a 
room in a house.

A collection can be 
placed within 
another collection 
by dragging it to 
the required 
position.

The icon associated with any given collection can be 
colour-coded. Select the collection, right-click and select the 
required colour in the popup menu.

Cable moved
to Floor Light

11

2Delete

Bulb
Deleted

1

2Delete

Only the
collection name

is deleted

2

Deletes collection
and its contents

1

2

3Result

Select colour
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The Properties Editor
has by far the largest 
number of options of
any editor panel.

A vertical list of icons 
on its left side act as a
set of tabs with each 
one taking us to a 
related group of 
di�erent options.

The icons shown here 
are those that appear 
when the Cube is 
selected.  

Near the base of the Blender window is the Timeline Editor. This is only used when we are creating animations. 

At this early stage in the learning process we may ignore the options shown here.

Exactly which icons 
appear depends on 
the scene item 
currently selected.

In this frame we can 
see the set of icons 
associated with the
Light object.

We’ll look in detail at
each option in a later
section.

Clicking on 
one of these 
icons will
display a set 
of properties 
on the right.

By default, the 
Object
Properties 
icon will be
selected.

Most 
property 
headings have 
several 
sub-properties.

Where a 
property title
is collapsed, it
displays a right-
pointing 
triangle.
Clicking on this
will expand the
property to 
show its set of
subproperties.

The lowest area in the Blender window is the Status Bar. This is used to display some of the options available to the user as a next 
operation.

Shows that left-
clicking on an 

object will select it

Dragging over
multiple objects

will select them all

Dragging with the
middle button will

rotate the viewpoint

Object Properties
icon

Expanded
property

} Collapsed
properties

Left-click
to expand

Left-click
to collapse

Right-clicking
will produce a
popup menu
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The default workspace is Layout and this contains the 3D Viewport Editor which is our view into the 3D world. It is here that we will 
create our 3D model. There are several elements within this Editor as labelled below.

The Heading area of the 3D Viewport contains four main areas. These show the current mode, a menu heading, edit controls and 
viewing options.   

We’ll be discussing each of these sections of the heading in more 
detail in a later chapter but for the moment we need only know 
that the Mode option dropdown has two entries of immediate 
importance: Object Mode and Edit Mode.  

Although we can use the dropdown 
list in the Heading area to switch 
between Object and Edit modes, a 
quicker option is to press the Tab key 
which toggles between the two 
modes. 

We work in Object 
Mode when we want 
to manipulate a mesh 
as a single object. 

In Edit Mode we can 
manipulate the 
individual vertices, 
edges and faces within 
the selected mesh.   

Navigation
Gizmo

World
x-axis

3D Cursor

Camera

Light

Cube

Header

World
y-axis

Grid
�oor

Cube’s
origin

Sidebar panel
(minimised)

Tool bar

View info

Object
info

The 3D cursor has
been moved from
its default position
at the World origin

Mode Menu Controls Viewing
options

These will be
discussed later

Tab

Switches between Object
and Edit modes

https://www.youtube.com/watch?v=sgq3wyyKh24
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Below, we can see how the image in the 3D Viewport changes between Object Mode and Edit Mode.

Notice that the menu options in the Heading area change depending on the mode we are using. Again, these will be discussed in detail 
in a later chapter.

Below the heading is the main area of the 3D Viewport. Near 
the top-left of this area are two lines of text. The �rst line 
gives viewpoint and projection details; the second line, the 
currently selected object.

When we are in a named viewpoint such as Front, Left or Top, an extra 
line of text appears. This gives the size of the squares in the grid that is 
added to the background as an aid to measurement.

Object Mode Edit Mode

Vertices &
Edges visible

Object Mode

Edit Mode

Viewpoint Projection
method

Cube
selected

Top Orthographic
(1) Colletion | Cube
10 Centimeters

Squares are
10cm x 10cm
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Blender automatically adds a Cube object to a new project. The 
Cube is one of the primitives available in Blender. The orange spot 
at the Cube’s centre, is its origin. When we set coordinates for a 
mesh, it moves in such a way as to place its origin at that point.

The view from the render camera is shown within the lighter 
coloured rectangle below. It is this area that appears in the 
�nal rendered image.

To deselect an item, all that is required is to left click in any empty 
area of the scene.

Although we can select a scene 
object by clicking on its name in the 
Outliner Editor, a much simpler way 
is to left click on the object itself.

In the main area of the 3D Viewport, the World x and y axes are 
shown on the grid �oor, but the z-axis is missing on start-up. The 
squares on the grid are one Blender unit  in width and depth. By 
default, each Blender unit is equivalent to one metre.

W
orld  x-axis

World  y-axis

1 metre

      Other options
are available Cube’s

origin

The light is 
responsible for 
lighting the objects 
in our scene. The line 
projecting from the 
centre of the light 
source indicates the 
direction of the light. 
The type of light (by 
default it’s a Point 
light), its brightness 
and direction can be 
changed. 

Light

Symbolic
ray of light

Camera

The view from the 
camera is what appears 
in the rendered image. 
We may think of the 
view we are seeing in 
the 3D Viewport as 
coming from a second, 
invisible camera.

View from the
render camera

3D
Cursor

The 3D cursor’s position 
determines where any 
new object is initially 
placed.
An object is placed so 
that its origin is 
positioned at the centre 
of the 3D cursor. 

Selects the object
under the mouse

pointer

      The selected
object has an 
yellow outline

1

2

Click in
empty area

Cube
deselected
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To delete an item from within the 3D Viewport, we must �rst 
select it and then press either the Delete key or the X key.

While the Delete key deletes the item immediately, if the X key 
option has been used, then Blender will require con�rmation of  
the action before removing the object.

We can add new meshes to our scene by selecting the Add|Mesh option from the 3D Viewport’s own main menu.

1

Select item

Delete item

2XDel OR 3

1

2X

1

2
Select required
mesh from this

list
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Na
vig

at
io

n
The Navigation 
gizmo - in the 
top right of the 
3D Viewport - 
contains 
several elements 
which we can 
use to perform 
various tasks 
such as change 
viewpoint, zoom 
in and out, and 
switch between 
perspective and 
orthographic 
view. 

 The �rst of these elements shows the orientation of the World Axes 
relative to the current viewpoint. Labels are displayed in the positive end 
circles and in the duller, negative ends only when the mouse pointer 
moves over them.

Axis directions
(negative ends)

X
Y

Z Axis directions
(positive ends)

Clicking on one of the circles will jump the viewpoint in the 3D 
viewport to a named direction (Front, Back, Left, Right, Top, or 
Bottom). The direction depends on which circle is clicked.  The 
current viewpoint (and other details) appear at the top-left. 

Current
viewpoint

      Jumping to a
named viewpoint 
always changes the
projection method 
to Orthographic

Clicking on the same circle as before (X) changes the view by 
180o. In this case, to the Left view. Of course, in the case of a 
cube, there’s not much di�erence!

Changed
viewpoint

If the mouse pointer is moved into the dark area between the 
coloured circles, a new, large grey circle will appear.

Grey circle
appears

Starting a mouse drag within the grey circle allows freestyle 
circular movement of the viewpoint about the centre of the 
screen.

The start and end
views in the 3D 
Viewport are
superimposed on
each other in this
image

This type of
viewpoint movement 
is know as orbiting

https://www.youtube.com/watch?v=HXY0vaLEs04
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The Zoom icon is the next element of the Navigation Gizmo.
Dragging the mouse up in this area will zoom in on the scene. 
Dragging down will zoom out. 

Zoom In Zoom Out

However, be aware that if we zoom in too far, faces nearest the
viewing camera may disappear from view. In the example below
most of the cube’s faces are no longer visible within the 3D
Viewport and we have moved inside the Cube.

Only two of the
cube’s faces remain

visible

By �rst placing the mouse pointer over the Move icon then
dragging in the left or right direction allows us to move our 
viewpoint to the side. 

Start and end
positions are
superimposed

Dragging vertically moves our viewpoint up or down.

Start and end
positions are
superimposed

The  Camera View icon allows us to toggle between the view from the camera object (which is used when rendering the �nal image) 
and the normal (user’s) viewpoint. To activate this option, click on the icon. 

User View Camera  View

Click to switch
between user

and render views

Only the area
in the brighter
box appears in
the �nal render
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The Projection icon allows us to toggle between perspective
 view  (where items further away appear smaller)...

All the cubes are
the same size

...and orthographic view where equally sized items are of 
identical size irrespective of their distance (although your brain 
may be fooled into thinking ones further away are larger). 

We’ve already seen that the 
Navigation Gizmo allows us to easily 
move to a new  viewpoint as well as 
zoom and switch between  
perspective and orthographic views. 

But Blender o�ers multiple ways of 
performing these tasks, many of 
which are quicker and simpler than 
using the Navigation Gizmo.  

It should be pointed out, before we start, that life will be a lot easier if we are using a full-
sized keyboard which includes a separate numeric keypad section (numpad). Also having a 
three-button mouse (the middle button being a scrollwheel) would be useful. 

Numeric
Keypad3-button mouse

with wheel

We can emulate the
existence of  the 
numpad and three
button mouse if
necessary by �rst
selecting Edit>
Preference 
from the main 
menu...

...to produce the Blender Preferences window. then clicking on 
Input on the left and then checking boxes Emulate Numpad and 
Emulate 3 Button Mouse.

2

1

Emulate middle
mouse button 
using Alt+left 
mouse button 

2

Uses standard
numeric keys in

place of Numpad

1
3

      Switching to a 
named viewpoint such 
as Right, Front or Top 
causes the projection to 
change to Orthographic.
The render camera view 
switches to Perspective.
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We’ve already seen how 
the Navigation Gizmo 
can be used to change 
our viewpoint by 
dragging the mouse 
within the grey circle.

But the simplest way to achieve the
same e�ect is to hold down the 
middle mouse button (or Alt+
left mouse button if you are using 
emulation) and drag the mouse 
anywhere in the 3D Viewport.

Another way of orbiting is to use keys on the numpad.  Pressing 4 
or 6 rotates the view about the user’s z-axis (in opposite 
directions) while 2 or 8 rotate it about the x-axis. Also, Shift + 4 or 
6 rotates about the y-axis. Each keypress rotates the view by 15o.

Orbiting is always around the centre of the screen. This can cause 
problems if the object we want to orbit is not at the screen’s 
centre. For example, if we start in the position shown below...

... and orbit using the middle mouse button, we get the rotation
shown below with the die apparently circling the centre of the 
screen (remember, it’s our viewpoint that is changing, not the 
position of the die).

To avoid this e�ect, we start by selecting the object we want to
orbit (in this case, the die) and then press the period ( full stop) 
key on the numpad. This moves our viewpoint so that the die is 
centred on the screen (and usually zooms in on it too).

We can zoom out if necessary (drag on the Magnify icon) and 
then orbit in the usual way (dragging on the middle mouse 
button). 

Orbiting

4 6

2 8

Rotate about z-axis

4 6 Rotate about y-axis

Rotate about x-axis

Shift +

1

2

Adjust
magni�cation

Orbit

Die now at
the centre of

our viewpoint

/

/

/
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Named viewpoints 
such as Front, Left 
and Top can be 
accessed by pressing 
the appropriate key 
on the numpad or in 
combination with 
the Ctrl key (as 
shown here). 

The numpad’s 9 key rotates the view by 180o about the viewer’s 
z-axis.

Since pressing 9 rotates the viewpoint by 180o, it is a useful
alternative way of toggling between named viewpoints such as 
Front and Back.

The other icons in the Navigation Gizmo also have numpad or mouse movement equivalents. 

Back  View1Ctrl

Front  View1

 Left  View3

Right  View3Ctrl

 Top  View7

Bottom  View7Ctrl

Before After9

Viewpoint
rotated by 180o

Before
(Front)

After
(Back)

9

Zoom Camera

Gizmo

Mouse

Numpad + Zoom in

0 Toggle View/
Render Camera- Zoom out 5

Toggle
Perspective/
Orthographic

ProjectionPanning

Pan left/right
up/down

Left

Right

Up

Down

Shift +

4Ctrl +
6Ctrl +
8Ctrl +
2Ctrl +

We can jump to a view of the whole scene by pressing the Home 
key. 
(In the “before” and “after” images below, only the right side of 
the 3D Viewport is shown.)

Home

Before After
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A little used zoom option allows us to draw a box around the 
area to be zoomed into. Pressing Shift+B sets up the box 
drawing, dragging and releasing the left mouse button de�nes
the size of the box and Blender then zooms into that area.  

All methods of zoom that we’ve looked at so far limit the amount 
of zoom available. But a �nal zoom option in Blender is the 
equivalent of moving the viewpoint camera itself closer or further 
away from the subject. This method (known as dolly zoom) 
requires us to hold down Shift+Ctrl while dragging with the 
middle mouse button.

Later, when we start to create and edit scenes, it can be helpful to be able to see an object from several viewpoints at the same time.
We can achieve this by pressing Ctrl+Alt+Q which splits the viewport into four equally sized view windows. Three of the windows show 
the named viewpoints, Top, Right and Front while the fourth retains the user’s current viewpoint. 
Each of these view windows acts as an independent viewpoint. When we move the mouse pointer into a speci�c window we can adjust 
that view in any way we wish such as zooming, panning or switching to another named viewpoint.

To merge the four views back to a single image in the viewport, we need only press the same key combination, Ctrl+Alt+Q.

1

BShift +

2

1

2

Zoomed in
(partially showing)

Shift + +Ctrl

Moving in too
far will make the view
pass through the object

RightFront

Top User

Toggle four viewpointsQAlt ++Ctrl
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In large, complex scenes such as a 
cityscape, the methods we have 
seen so far for changing the 
viewpoint may not work as well 
as we would like. 

An alternative approach is to 
allow the viewpoint changes to
use the same techniques as we 
see in a typical  �rst-person 
shooter (FPS) game.

This approach allows us to “walk” 
through our scene with any 
zooming, panning or orbiting 
happening relative to our current
position within the scene.

To access Walk Navigation we need to 
select View>Navigation>Walk Navigation from 
the main menu.

Once in “walk” mode, 
moving the mouse 
pointer (no button 
presses) allows us to look 
around while the keys W, 
S, A, D, E, Q and the 
arrow keys control 
navigation.

E and Q only work when 
gravity is o� (see below). 

Pressing Esc will exit 
“walk” mode.

When we switch to walk mode we’ll also notice that the mouse
cursor changes to the typical crosshairs of a FPS game.

Pressing the left mouse button returns us to normal navigation.

Holding down the Shift key while pressing one of the navigation 
buttons will speed up the movement.
Holding down Alt while navigating will slow down movement.
To permamently change the speed, scroll the mouse wheel or use 
the numpad’s + or - keys.

While in “walk” mode, pressing the Tab key will introduce the
e�ect of gravity causing the user’s view to fall until a solid surface
is encountered.  Pressing Tab again will remove the gravity e�ect.

Walk Navigation

Navigation

View

Look around

Move forwardW

Move backwardS

Sidestep leftA

Sidestep rightD

Move upE

Move downQ

Crosshairs

Shift + W S A D E Q

Temporarily Increase Speed

Permanent Speed Change
Increase Decrease

+ W S A D E Q

-

Temporarily Decrease Speed

Alt

View 
(no gravity)

View 
(gravity)

Viewpoint has
fallen to plane

Tab

The Q and E keys
have no e�ect when
gravity is on.

/
/
/
/

/ /+
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The �rst of these 
icons, is the 
Selectability and 
Visibility settings.

Clicking on its 
dropdown button 
displays a set of 
options which we 
can use to hide a 
whole class of 
objects with a 
single click or make 
that group of 
objects 
unselectable.

The second icon is 
named the Gizmo 
Visibility icon and 
a�ects the visibility 
of various controls 
that appear within 
the 3D Viewport.  

At this point we 
need only know
that the �rst 
checkbox controls 
the visibilty of the 
Navigation Gizmo 
icons.

It’s the third  icon - 
Viewport Overlays  - that 
supplies options which we 
are more likely to make use 
of.

Here we can show or hide
items such as the grid �oor,
world axes, 3D cursor, 
object origins, and the 
orange outline around the
currently selected item.

The checkboxes and
buttons used to control
these and other elements 
are outlined in yellow here.

Notice that the Gizmo 
Visibility icon has a 
blue background.

This indicates that the 
options selected 
within its panel are 
active. 
If we click on the icon 
itself, we can switch 
o� all the options it 
contains as indicated 
by its now grey 
background.

At the right of the Header area there are a set of icons that are resposible for controlling 
what and how we see the elements in our scene.

When working in the 3D 
Viewport there are several 
options available to us to 
control what elements are 
visible or selectable within 
our scene.

We can also control the 
colour of objects and the 
lighting of our scene.

These colours and lighting 
e�ects can be set to be 
applied only while we are 
working on our scene or to 
be applied to the �nal 
render.

Vi
ew

in
g  

a  
Sc

en
e

Light

Mesh

Camera

Click on the EYE
symbol to toggle

visibility

ARROW toggles
selectability

These icons
control the visual
aspects of a scene

Controls the
visibility of the

Navigation
gizmo

Navigation
gizmo

Before After

1

2

https://www.youtube.com/watch?v=Kua7S2rvne8
https://www.youtube.com/watch?v=R_OHqj7rRQA
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Below we can see the visibility controls matched to their various 
items.

Scale’s value determines the size of the squares on the Grid (if in a 
named view) or on the Floor (if in User view)

Annotate, when checked, displays any drawings created using 
the Annotate tool from the Toolbar.

Statistics, if checked, displays additional information about the 
objects, vertices, edges and faces. The total values for the scene 
and the number currently selected are shown. The number of 
triangles are also shown since these are used in video games. 

Grid controls the visibility of a grid which is available only when in 
a named viewpoint such as Front.

Origins (All), when selected, shows the origin of every item in the 
scene - even those that are not currently selected. The origins of 
unselected items are shown in white.

Front View

Front View User  View

Additional info
displayed

Cube
selected

1

2 Origin of
the Plane
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Wirefram[sic] , when checked, displays the edges within a frame. Typically, when the edges are displayed in this way, we refer to the 
resulting display as wireframe.  There are two parameters associated with this option. The Wirefram �eld adjusts how many edges are 
actually displayed. Lower values remove displayed edges that are common to faces that are at lower angles to each other.  Opacity 
adjusts the visibility of all edges. Values close to zero make all edges disappear.

Face Orientation, when checked, displays front faces in blue and 
back faces in red. Normally, back faces are hidden, but below we 
can see that some back faces are exposed within the opening in 
the torus.

One more option is 
added to the  
Viewport Overlays 
panel when we enter 
Edit Mode.

The new Fade 
Inactive Geometry 
entry allows us to 
control the visibility 
of unselected objects. 
This can be useful if 
these objects obscure 
the one we are trying 
to work on.

New option
available in
Edit Mode

In the example below, the Torus has been selected before 
entering Edit Mode. The Fade option has then been used to 
reduce the visibility of other elements. 

Edit Mode

Another result of 
entering Edit Mode is 
that we are 
presented with an 
additional entry in 
our block of icons.

This is the Edit Mode 
Viewport Overlays 
icon with its 
advanced set of 
options.

Most of these can be 
ignored at this time, 
but one item of 
interest is ...
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Like the Gizmo Visibility icon, the Viewport Overlay icon can be 
deactivated by clicking on it to disable every option that has been 
selected within its panel. Below we can see the display when the 
options are active.

When the Overlay Visibility icon is disabled, the Edit Mode 
Overlay Visibility icon is also automatically disabled.

The next icon is the X-Ray Mode icon. This icon - which has no 
dropdown panel - adds a level of transparency to all the objects 
in our scene as shown below.

However, X-Ray Mode is really designed to be used in Edit Mode where it allows us access to elements of the currently selected mesh 
that would normally be hidden from our viewpoint.

...the Normals option. This allows us to make normally invisible 
face, vertex, and vertex average normals show on the screen. 
Each normal type is colour-coded. The value to the right adjusts 
the length of the normals. 

Normals

Select to
show normals

Vertex
Vertex

average

Face

Enabled

Disabled

Edit Mode
X-Ray OnX-Ray O�

More elements
visible
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Wire Color determines the colour of the mesh edges. 
Theme uses the colour speci�ed for the Blender theme we 
selected in the �rst Splash Screen. All meshes are assigned the 
same colour.  

Object colours the 
edges according to 
the colour set up for 
each object in its 
Properties Editor’s 
Object Properties 
page. 

On the right we can 
see that page for the 
monkey head.

The �nal four icons control the shading in the 3D Viewport. 
Because they share a common purpose and are mutually exclusive,
they appear together in a group with the Shader Settings button
at the end of the group. }

Viewport
shaders

Shader
settings

The �rst of the group displays the scene in Wireframe mode, 
showing the edges that make up the meshes in our scene.

Wireframe
mode

Shader
settings

Objects shown
in wireframe

Monkey
head colour

The Shader Settings button creates a panel with several entries 
as shown below.
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Random assigns a random colour to the each object’s edges. Background is the next heading in the panel. Again, there are 
three possible values.
Theme uses the colour speci�ed in our selected theme. 

World uses the colour de�ned in the Properties Editor’s World 
Properties page in the entry Viewport Display>Color. 

Viewport, when selected, creates a colour bar where we can 
select any colour for the background.

Returning to our Wireframe parameters panel, the next heading is Options. Here we �nd X-Ray. When switched on, this displays edges 
that are normally invisible from our viewpoint. The associated value adjusts the opacity of these newly seen edges.

Select
colourBackground

colour
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Outline is the �nal entry in our panel. This sets the outline colour 
of all meshes. The outline is de�ned as the set of edges on the 
border of a mesh as seen from our viewpoint. Here we can see the 
red outline on the monkey.

Solid Shading is the next of our Viewport shaders. This is the 
default shader used when we start a new project.

If we’ve not set up any other options in the Properties Editor, the 
meshes in our scene will appear in shades of grey.

This time, the Shader Settings button 
creates a panel with many more options 
than we saw in the Wireframe’s panel. 

Lighting gives three options. Studio lighting has, itself, six 
options, the selected one being represented by the sphere 
beneath. If we click on this sphere, we’ll see all six options in the 
shape of more spheres.

Clicking on one of the spheres will change the lighting on our die. 
Two examples are shown below. 

Select
colour

Default
option
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Rotation is a value �eld beneath the sphere. Adjusting the value 
here will change the direction of the light and hence the shadows 
displayed on the objects. Below we can see the e�ects of di�erent 
Rotation values (using second-from-left sphere)

As we move our viewpoint, the light remains consistent and the 
shadows remain �xed. The example below uses the same 8.1o 
value as in the last image and the 2 remains in deep shadow as 
our position is moved.

However, if we click on the Globe icon to the left of Rotation, to 
disable it, the shadow moves as our viewpoint changes and the 
Rotation value is no longer used.

MatCap (short for Material Captures) is the next Lighting option. 
Again, the sphere beneath, when clicked displays a larger and 
more colourful set of options which set both lighting and surface 
material for all meshes.

If we pick a more dramatic option, we can see how this 
a�ects the die.

Note that if we’ve assigned other Viewport colours to a mesh (we can do 
that in various pages of the Properties Editor), the MatCap selection is 
added to that colour. In the example below, the monkey head has been 
assigned a blue colour and a striped MatCap.

1

2

Default
option
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Flat is the �nal Lighting option. When selected, no lighting is 
added and we get a �at, ambient light e�ect.

Although we can’t rotate a MatCap light in the same way as we 
can with Studio lighting, the doubled arrowed line to the right, 
when clicked mirrors the e�ect created as shown on the monkey 
head below.

Wire Color, the next heading in the panel, is the same parameter 
we saw earlier in Wireframe Mode. However...

...it is only relevant in Solid Mode if we have selected 
Geometry>Wirefram in the Viewport Overlays panel...

...in which case, the edge will be made visible in the speci�ed 
colour.

Color, the next heading in the panel, is used to specify which 
colour the surface of our objects is to display. Although these 
colours are not designed to appear in the �nal render they may be 
useful in other ways during the modelling process. 

2

1
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NOTE

Material, sets the colour of an object to that speci�ed in the 
Materials page of the Properties Editor. It can be found under the 
heading Viewport Display>Color. Below we can see the settings for 
the monkey head.

Object, when selected causes each object to display the colour 
de�ned for it in the Object Properties page, Viewport 
Display>Color. Below, we see the setting for the torus.

Attribute, sets an object’s colour to that de�ned in the Data 
Properties page, Color Attributes. How this colour is set up is a 
little di�erent from the previous two and will be discussed in a 
later chapter. Below is the setting for the UVSphere.

Single shows every object in the same 
colour. The colour is selected in the colour 
bar that appears below the six Color options.If no colour is 

set in the 
Data 
Properties 
page, the 
colour 
de�ned in 
the Object 
Properties 
page is 
shown. 

Random shows each object in a di�erent, pale colour. Texture sets the object to display any true texture it has been 
assigned in the Materials page. If none has been de�ned it will 
show the colour de�ned in the Object Properties page.
But...

Select
 colour here

Select
 colour here

Set
 colour here

Select
 colour here

Displays any
texture de�ned

here



Blender Basics: Starting Blender 55

... there is an additional requirement needed before the texture is 
successfully displayed. The Object Properties page must have its 
Viewport Display>Display As set to Textured.

Backface Culling is the next new entry in the panel. When 
selected this hides all the back faces currently visible. In the scene 
below, only the internal part of the torus is a�ected.

X-Ray, as we’ve seen before, is best suited for use in Edit Mode 
where we can gain access to elements normally hidden from our 
current viewpoint. The associated value adjusts the visibility of 
the object’s surface.

Shadow, when selected, creates a shadow on the surface of each 
object with the associated value controlling the intensity of the 
shadow.

Moving the mouse pointer over the cogwheel creates a small 
panel o�ering three more adjustments to the shadow. 

Dragging over the Shadow Direction sphere adjusts the 
direction of the light creating the shadow.

Set to
Textured
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Shadow S[hift] shifts the shadow along the surface of each 
object.

Shadow F[ocus] adjusts the focus of the shadow terminator.

Although we’ve created shadow on the surface of each object, if we want an object to cast shadows onto other objects within the 3D 
Viewport, then we need to select the object then go to the Object Properties page and check the box Viewport Display>Shadow. 

We need to do this for each object that we want to cast a shadow.

Cavity is the next entry in the Solid Shading’s panel. This option 
adds shadows and highlights on the surface of an object to 
emphasise valleys and ridges in all the meshes in the scene.

By checking Cavity we add a few extra parameters to the panel as 
shown below.

Monkey head
shadow

New options
in panel
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Type o�ers three options in its dropdown list:
World takes into account the size of the ridges and valleys in the mesh and is the more complex of the two options, taking longer to 
calculate.
Screen is less accurate but faster.   Both, uses both methods at the same time.

In addition, we have Ridge and Valley �elds to 
adjust the highlights and shadows created by 
the Cavity e�ect. If we’ve chosen the Both 
option, there are separate adjustments for 
World and Screen.

Below we can see the e�ects created for di�erent Ridge and Valley settings when 
using the Screen type only.

There is a practical use for the Cavity e�ect. Below we can see the 
di�erence between a set of steps as viewed without and with 
World Cavity.

When using the World option we get an added cogwheel. 
Moving the mouse over this produces another small panel where 
we can  add subtle adjustments to the Cavity e�ect. 
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Depth of Field is the next entry in the Solid panel’s settings. This 
is only relevant when viewing the scene through the render 
camera (pressing 0 on the Numpad toggles between the render 
and Viewport cameras). 

To set up the Depth of Field we must start by selecting the render 
camera (click on the Camera itself in the 3D Viewport, or its entry 
in the Outliner Editor).

Then, in the Properties Editor, we must select the Camera’s Data 
Properties page, check Depth of Field and reduce the F-Stop 
value to around 0.1 for maximum e�ect. We may also need to 
adjust the Focus Distance.

Now, when we change to the render camera view, objects away 
from the Focus Distance value will  appear blurred.

Outline, we’ve come across before in Wireframe Shading and this 
sets the outline colour for all objects.

Specular Lighting is only available when Lighting is set to Studio. 
When selected, this adds a shininess to the surface of all objects.

1

2Adjust
value

Check to
activate
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Material Preview is the next shading option. As the name 
suggests, this is the �rst shader to give a display closer to the �nal 
rendered image.

Below we can see how our scene looks after textures have been 
added to meshes. Blender will use the Eevee render engine to 
create the scene.

The adjustments panel for this 
shading option is shown here.

The main options control the 
lighting of the scene.

Scene Lights, when checked, include the e�ects of any light 
objects that have been placed in the scene. This includes the 
Point light which is created by default. If this option is unchecked 
the lights placed in the scene are ignored.

Scene World is the term 
used to denote the 
environment surrounding 
our scene. 

Typically, this is a 360o image 
referred to as High Dynamic 
Range Image or just HDRI. 

The light that would come 
from such an environment 
in the real world is added to 
our scene to create a more 
realistic e�ect.  

With the Scene World box unchecked, the surrounding environment is assumed to be one of the 
HDRIs available by clicking on the sphere beneath.

Select an
HDRI
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The e�ect of two of these HDRIs on our scene is shown below.

The next group of values controls various aspects of the HDRI.
Skipping �rst to World Opacity, this controls the visibility of the 
HDRI image. If we set the value to its maximum we have a better 
view of the image used.

Blur adjusts the focus of the HDRI. 

Strength adjusts the brightness of the HDRI and hence adjusts 
the strength of the light falling on our scene.

Rotation rotates the HDRI about our scene allowing us to see a 
di�erent part of the image from our current viewpoint. This also 
a�ects the direction of the light coming from the HDRI.
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Normally, when we change viewpoint, we’ll see a di�erent part of 
the background image...

...but if we click on the globe to the left of Rotation, the �rst 
change is that the HDRI adjusts to its default position, ignoring 
the rotation setting...

...and as we change viewpoint, the background remains  
unchanged.

Render Path determines which part of the scene is displayed in 
the Viewport. This gives us options to display the component 
parts on their own.  

For example, we can use this parameter to show only the shadows created in the scene. Or to show only 
the HDRI.

The Viewport Shading 
panel’s last entry is 
Compositor which 
controls the availablity of 
the Blender compositor. 

A compositor combines 
several images into a 
single image . 

This is an advanced topic 
not covered in this text.
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HDRI that we employ through this panel will not appear as 
background in the �nal renderd image. If we want the HDRI to be 
included, we must start by checking the Scene World box...

... and then move to the Properties Editor’s World Properties 
page. There we need to click on the Surface>Color.

Clicking on 
that yellow 
dot produces 
a panel of 
options.

Environment 
Texture is the 
option we 
require in 
order to add 
an HDRI.

Immediately after selecting this option, the scene will take on a 
light purple colour. This is Blender telling us that it hasn’t yet been 
given the name of a valid image �le.

Now we need 
to select Open 
from the  new 
options on 
the World 
Properties 
page.
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This will 
produce 
Blender’s 
Open File 
dialog box 
where we can 
select the 
image we 
want to use 
as the 
background.

Note that an HDRI 
is not a standard 
image.

These image �les 
have the extension 
.exr and can be 
downloaded for 
free from various 
websites such as 
polyhaven.com.

Once loaded, our scene will display the new image in the 
background.

It will also appear in the �nal render.

Rendered Shading is the �nal option for the Viewport display. 
This gives us a result which is close to the �nal render but from 
the prespective of the Viewport camera. 

In the Render Properties page of the Properties Editor we can 
select between Eevee and Cycles. But although Cycles gives a 
more accurte result it takes much longer to calculate and will be 
impractical on all but the fastest machine.

Note that Rendered
has the same panel

options as 
Material Preview

2

1

Select
render engine
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Meshes in Object ModeMeshes in Object Mode

In this section we’ll cover the following topics:

 How to create and delete mesh primitives such as cubes, spheres  
  and cones.
 How to set the initial properties of primitives. 
 How to adjust the units of measurement. 
 The purpose of the 3D cursor. 
 How to adjust an object’s origin. 
 How to resize, rotate and move mesh objects.
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When constructing a scene 
we often start with one or 
more primitives. 

We have some control over 
the initial appearance of 
these primitives so we can 
adjust some of their 
characteristics to suit our 
requirements.

When we start a new project, Blender automatically adds a Cube. We can see from the 
orange outline that the Cube is also selected. 

When working in the 3D Viewport, we can deselect an object by 
clicking in an empty area of the scene.
We can select an item by left-clicking on it.

To delete a selected object, press either the Delete key or the X 
key. Using Delete deletes the item immediately, but X requires 
con�rmation before the deletion is actioned.

It’s also useful 
to know that 
any action we 
perform can be 
undone by 
pressing Ctrl Z. 
For example, if 
we have 
deleted the 
Cube but then 
decide we 
want to keep it 
instead, we 
need only 
press Ctrl Z to 
have it 
restored.

The �rst 
option is to 
choose
Add>Mesh 
from the 
Viewport’s 
main menu 
and then 
choose 
from the 
submenu 
list of 
primitives.

The second option is to choose
Shift A to create the same menu but 
this time as a popup. 

To add a new 
primitive to 
our scene, we 
need to use a 
menu option.

There are 
two ways to 
do this. 

Selected
Cube

Click in empty
space to

deselect all

Click over an
item to 
select it

Delete

Immediate
deletion

X

Requires
con�rmation

1

2

Select required
primitive

AShift Popup
menu
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NOTE

We’ll start by creating a Plane, the �rst of the listed primitives and 
also the simplest with only four vertices, four edges and a single 
face. Remember, a new object is always placed over the 3D cursor.

Many operations we perform during modelling creates a Last Op 
panel (also known as the Operator panel) in the bottom left of the 
3D Viewport. This allows us to adjust various parameters of the 
operation we’ve just performed.

The �rst parameter for the Plane is Size 
which speci�es the length of each side. If we 
change the value here, the Plane itself will 
change size.

Generate UVs 
refers to 
texturing and 
will be 
discussed in a 
later chapter. 

Align determines which z-axis the mesh is 
aligned along. By default it is the World’s z-axis, 
but if we change this to View (whose z-axis 
points out of the screen), the Plane aligns 
directly with our viewpoint.

1

2
Plane created
over the 3D

cursor

Last Op
panel for 
Add Plane

A Last Op panel 
only exists until 
another 
operation is 
performed at 
which point it is 
replaced by a 
new Last Op 
panel.

5m Plane
increases

in size

      The 3D Cursor 
option will be 
discussed later

The next set of values, labelled Location, sets the position of the
plane by moving it so that its origin is at the speci�ed location. In 
the example below the plane is moved so that its origin is at 
location (3,-1,2). 

Finally, Rotation speci�es the plane’s rotation about the x, y and z
axes. Normally, this will be measured from the plane’s own global
axes. Rotation is measured in degrees by default. Below a plane is 
rotated 45o about its y-axis. 

3

-1

2

Location X 3

-1

Z

Y

2

Rotation X 0

45

Z

Y

0

45o

Plane’s global y
-axis

Plane’s original
position

Plane’s new

position
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If we delete our plane and then create a new plane we’ll see that 
Blender has remembered the last Size setting and has created 
this new plane with sides 5 metres in length but the Location and 
Rotation values are reset.

New
plane

5m

Once we’ve selected Add>Mesh>Cube from the 3D Viewport’s menu,
we can see that the cube o�ers the same initial properties in the 
Last Op panel as the Plane:
Size, Generate UVs, Align, Location and Rotation.

After deleting the Cube we can add the next mesh option, Circle. 
This creates a shape made only of vertices and edges. There are 
no faces. But the Last Op panel has some additional options. 

Last Op
panel

Cube

Circle

New
options

Vertices gives the number of vertices around the circumfrence of
the circle. If we reduce this value the shape becomes less circle-
like.

Vertices 9 Vertices 3

Radius sets the radius of the circle. Fill Type o�ers options to 
create one or more faces for the inner part of the circle. Ngon �lls 
the circle with a single face. Triangle Fans creates a set of tris (3
edge faces) meeting at the circle’s centre. 

Fill  Type Ngon ∨ Fill  Type Triangle Fan ∨

To view the faces
press the TAB key to
enter Edit Mode

UV Sphere is the next mesh option. The Last Op panel has two 
new options. These are Segments and Rings. The faces that 
make up a single vertical loop is a segment. Faces that make up 
a single horizontal loop is a ring.

Segments 32

Rings 16 Segment

Ring

       View the structure 
of the sphere in Edit 
Mode 

     Vertices, Radius and 
Fill Type values will be 
reused by any later 
Circles

     Segment, Ring and 
Radius values will be 
reused
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Cap Fill Type determines the type of face used to �ll the top and 
bottom of the cylinder (ngon or tris) or to leave them un�lled. 

The Ico Sphere mesh is constructed from tris. The only new Last 
Op panel option is Subdivisions which, in e�ect controls how 
many tris are used to create the sphere. 

Subdivisions 2

The Cylinder has some features similar to the Circle since the top
and bottom of the cylinder are, in e�ect circles. This means that
some of the Last Op panel options are similar to those 
of the Circle.

Reducing the Vertices value gives a less rounded shape.
Increasing the Vertices makes the curve smoother.

Vertices 3 Vertices 51

Radius sets the radius 
of the cylinder.

Radius 0.4 m

The Depth setting adjusts the height 
of the cylinder.

Depth 0.56 m

Base Fill Type Nothing

The Cone mesh’s options are mostly familar but they include two 
Radius values.  

     Subdivisons and 
Radius values will be 
reused

     Subdivisons and 
Radius values will be 
reused

     Vertices, Radius, Depth 
and Cap Fill type values 
will be reused
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Radius 1 adjusts the width of the Cone’s base.

Radius 1 2 m

Radius 1

Radius 2 adjusts the width at the top of the Cone. For any value
other than zero, we no longer have a true cone shape with the 
mesh acquiring a top cap.

Radius 2 0.5 m

Top cap

Radius 2

Base Fill Type determines how the base and top caps are handled 
(options being: none, ngon, or tris). Below, we see the result of the 
caps having been removed.

Base Fill Type Nothing

Vertices allow us to create a pyramid shape (values 3 or 4) or a 
very smooth curved cone shape (value 100).

Vertices 3 Vertices 100

Depth sets the height of the Cone.

Depth 0.5 m Depth 5 m

The Torus is a doughnut-shaped mesh with many unique options. 

     Vertices, Radius1, Radius2, 
Depth  and Cap Fill Type 
values will be reused
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The option Major Segments refers to the number of faces that
make up a horizontal loop. Minor Segments refers to the number
of faces that make up a vertical loop.

Minor Segments
loop

Major Segments
loop

Reducing the Minor Segments to 3 gives us the shape shown 
below left. Reducing the Major Segments to 3 as well, gives us 
the shape shown below right.

Major Segments 3Major Segments 48

Minor Segments 3 Minor Segments 3

The Major Radius is the distance from the centre of the Torus to
half way through the solid ring.
The Minor Radius is half the width of the outer ring.

Major
Radius

Minor
Radius

By adjusting the Major and Minor Radius values we change the 
overall  size of the Torus, the size of the hole in the middle and the
thickness of the Torus. 

Major Radius 1.2m

Minor Radius 0.25m

Major Radius 0.3m

Minor Radius 0.25m

An alternative method of resizing the Torus is to select the 
Dimensions Mode’s Exterior/Interior option This changes the 
two values displayed below to Exterior Radius and the Interior 
Radius.

1

2
Changes

to

The radii measured by Exterior Radius and Interior Radius are 
shown below.

Interior
radius

Exterior
radius
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Because of the many options available when setting up a Torus,
Blender o�ers a way of saving and naming a set of attribute 
values so that another matching Torus is easily created. To do this 
we must �rst set all the necessary Torus values and then click on 
the + sign to the right of Operator Presets in the Command 
Settings panel.

This opens a new panel where we can specify a name for the 
current value settings. When another Torus is added, the name
can then be selected to apply the associated settings to the Torus.

The next mesh option, Grid, may look identical to the Plane 
mesh but if we look at its structure in Edit Mode, we can see that 
it is constructed from many more faces.

Even if we haven’t saved the 
various Torus settings in the 
way described, any new Torus 
will make use of the current 
settings of the following 
parameters:

 Major Segments
 Minor Segments
 Dimensions Mode
 Radius settings
  

Grid’s Last 
Op panel 
options 
allow us to 
specify the 
number of 
faces in both 
the x and y 
directions. 

X Subdivisions, 
Y Subdivisions 
and Size 
settings are 
reused by 
subsequent 
Grids. 

The �nal mesh is a monkey head - a�ectionately known as 
Suzanne. Although not a true primitive, it is often used to show 
o� various features of Blender. 

When adding
another 

torus

1

2

1

2

Clicking on the - icon will
delete the last named preset
to have been used.

Deletes the last
named preset
from the list

A Grid is made 
from many faces

Tab Edit Mode/
Object Mode

Number of
faces in each

direction
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When creating a mesh we should always go for the minimum number of faces we require since not only will we reduce memory and 
processing requirements, but this can also make the modelling process much easier when we are working in Edit Mode. For example, 
one of the Grids below is created with 10 faces while the other has 100. In the modelling process we want to raise one end of the grid. 
Both end up with exactly same result but one takes a lot less e�ort for both the modeller and the machine.

One situation where we might be tempted to increase the 
number of faces is when creating a curved surface. For example, 
we can see that the second sphere below looks more curved than 
the �rst.

But if we use the �rst version of the sphere and apply smooth 
shading (Object>Shade Smooth) we get a more curved look to the 
object without adding more faces. This e�ect is achieved by 
adjusting the normals of the sphere.

In fact, the only visual clue to the sphere’s low face polycount is 
the straight edges on its pro�le.

However, if the sphere will only ever be viewed from a distance in 
our completed scene, the problem with the the pro�le disappears 
as seen below.

10 by 1 Grid Select 1 face Move up

Move up
Results identical

Select 10 faces10 by 10 Grid

Straight
edge pro�le

Same sphere
seen from a

distance
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The Shade Smooth option works well with the IcoSphere and Torus as we can see from the before and after pictures shown below. 

However, when we apply Shade Smooth to a Cylinder, the result 
looks wrong.

The trouble is that Shade Smooth is attempting to smooth out 
the whole surface of the Cylinder when all we want is to smooth 
out the vertical, curved section. Luckily, the Last Op Panel has a 
parameter for Shade Smooth that helps with the problem.

By checking Auto Smooth, Blender only smoothes out faces 
which are at an angle of 30o or less to each other  - the angle value 
can be changed. Since the top faces of the cylinder are at an angle 
greater than 30o to the side faces, we can achieve a better result.

We need to check the same Auto Smooth option when applying 
Shade Smooth to a Cone.

Original With Shade Smooth With Shade SmoothOriginal

Original With Shade Smooth Check this box
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When we start a new project in Blender, the Metric 
system is used by default, with one Blender unit of 
distance set equivalent to one metre. This means that 
our default Cube is 2 metres in all three directions.

We can see the size of 
an object in both the 
Last Op panel when 
the object is created, 
and also in the 
Sidebar’s Item page 
where the size in each 
of the three  
dimensions is given.

The units we are 
using can be set 
in the Scene 
page of the 
Properties Editor.

Unit System gives us a choice of Metric or Imperial with a third 
option, None, removing any link between real-world size and 
Blender measurement units.

When we choose Metric, the Length �eld lower down the list of 
�elds o�ers measurement units of anything from a kilometre 
down to a micrometre.

When we choose Imperial, we get the old British measurements 
which are still used in the USA. This ranges from miles to thou 
(one thousandth of an inch).

M
ea

su
re

m
en

t  U
ni

ts

      
m is short for

metres
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Both Metric and Imperial have a Length option labelled Adaptive. 
This allows Blender to use the most appropriate units when 
displaying values. For example, if we are working in Metric and 
create a Cube de�ning it size as 0.5 metres, Blender displays 50cm.

Separate Units is a checkbox, which, when selected, shows 
named units rather than fractions where possible. Here, when 
working in Imperial,  we have created a Cube which has a size of 
2.5 feet this is then displayed as 2 feet 6 inches.

If you are not familar with the Imperial 
system, the tick marks by the numbers - 
properly called “prime” and “double prime” - 
are the shorthand used for “feet” and “inches”.

Rotation 
can be set 
to degrees 
or radians.

Mass, Time, and Temperature  are only of use when we are 
using physics to create realistic animations. But note that Mass 
and Temperature have di�erent settings for Metric and Imperial.

Unit Scale should scale distances appropriately. But, making use 
of it causes display problems as shown below when a 2 metre 
Cube is created. So, it is best to ignore this �eld, leaving it set to 
1.0.

However, Scale in the Viewport Overlays panel can be adjusted 
when working on a di�erent scale from the default metres or feet. 
For example, setting Scale to 0.001 when using metric, will set the 
smallest grids shown in named and user views to exactly 1mm. 

Displays
as

Enter as
0.5 metres

Displays
as

Size 2' 6''

Prime
(feet)

Double prime
(inches)

Metric Imperial

1mm
squares
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